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Introduction to Microsoft Excel 2010
Handout from Lodi Memorial Library
(Developed by Barb HauckMah for ESL Tech Literacy Grant;
Modified by Jennifer Cohen Feb. 2015)

What is Excel?
It is a Microsoft Office computer software program that organizes and
analyzes numbers, data, and labels in spreadsheet form. Excel
makes it easy to translate data tables into charts and graphs.

What we will learn in Introduction to Excel
HOW TO:
● Open and save Excel files
● Enter data and move around a spreadsheet
● Use Excel formulas
● Write basic math formulas
● Identify and edit mistakes
● Change the style and format of data
● Print a spreadsheet

How to open Excel
1. Click the Start button in bottom left corner of computer screen
2. Point to 
Programs 
or 
All Programs
.
3. Scroll to find 
Microsoft Office
in program list and
4. Click on 
Microsoft Excel 2010
to open.
TIP Right click Microsoft Excel 2010 on Microsoft Office menu and click on 
Pin to Start
Menu
or 
Create Shortcut
. Now Excel will be in the start menu or on your desktop,
respectively. You can just click on it to open (you’ll need to doubleclick it if it’s a
desktop shortcut; buttons in the start menu only need to be clicked once).
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When you open Excel, a new
worksheet opens.
An Excel spreadsheet is a grid with
COLUMNS, ROWS, and CELLS. It looks
like an accounting spreadsheet.

A
column
is one vertical collection of cells from top to bottom
in the spreadsheet. In the picture to the left, Column C is
highlighted.

A
row
is one horizontal collection of cells from left to right in
the spreadsheet. In this picture to the right, Row 4 is
highlighted.

A
cell
is one of the black boxes that make up the columns and
rows. A CELL NAME is the column letter and the row number.
When you click on a cell, you can see the cell name in the cell
name box. In this picture to the left, Cell C4 is highlighted.

How to move around the Excel spreadsheet
Using the two scrollbars:
They are on the right side and the bottom of the screen. The
scrollbars help you to move up and down or left and right really fast.

Moving to a cell:
Point at a specific cell with your mouse and click on it using the left
button.
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Using the keyboard:
Click Up Arrow key to move UP one
cell. Click Down Arrow key to move DOWN one cell.

Moving across a row:
Click left or right arrow keys to move
LEFT or RIGHT one cell at a time. You can also click the Tab key to move to the RIGHT
one cell at a time.

Practice 1 Moving around in Excel
1. Open Excel.
2. Click on Column B.
3. Click on Row 6.
4. Click on Cell C6.
5. Use the Tab key to move to Cell E6.
6. Move from Cell E6 to Cell A8.
7. Scroll down to Row 20.
8. Scroll over to Column P.

Practice 2 How to highlight cells in Excel
1. Put the cursor to the left or right of the cell(s) you want to
highlight.
2. Put your pointer finger on the left mouse button.
3. Press and hold down the left mouse button.
4. Move the mouse across the cell(s) you want to
highlight.
5. Lift up your finger.
6. You will see that the first cell you highlighted is
white; the rest are a grayishblue.
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How do I deselect cells?
If you want to get rid of the highlighting, click on a
white part of the screen. This will stop the
highlighting; the greyishblue color will go away.

How to add data to a spreadsheet
Three types of data can be typed in an Excel cell:

How do I put data in a cell?
1. Click on a cell.
2. Type in a word or a number.
3. Press Enter key. This will take you to the next cell
below.
4. Type another word or number.
5. If you want to move to a cell to the left or right, press the left or right arrow keys
on the keyboard.

Editing and deleting data

How do I change data I typed in a cell?
1. Click on the cell that has the data you want to change.
2. Type different data in the same cell.
3. Press the Enter key.
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How do I delete data?
1. While in a cell, use the 
Backspace
key to delete a character at a time. You can
then retype the data the way you want it to be.
2. If you want to delete the contents of an entire cell, click on that cell and then
press the Backspace key.
3. If you want to delete the contents of multiple cells, highlight those cells and then
press the 
Delete 
key on your keyboard.
How do I change data that’s in a cell?
1. Click in the formula area of the 
Formula Bar
.
2. Press backspace to delete what you want and then retype the data.

Practice 3 Create an Excel worksheet
Start in Cell A2. Enter the data in each cell as shown in the table below.
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Practice 4 Save a new Excel file
1. Click the 
File
tab in the top left corner of the screen.
2. Choose the 
Save as
option from the File menu.
3. A popup menu of 
My Documents 
will open.
4. Click in 
File
name

box towards bottom of popup
menu. Highlight the words that are already in the
box before deleting them. Then type in what you
actually want to call the file.
5. If you know you’re going to be opening this file on a
computer that has a Microsoft Excel version that came
out before 2010 or if you’re not sure what version the
computers you’ll be using to open it has, you’ll want to
choose Excel 972003 Document from the 
Save as
type
drop down menu, found right below the File
name box. This will save the file as a .xls file, which
can be opened by computers with Excel software from
19972007. Excel 2010 regularly saves documents as
a .xlsx file, which can only be opened by computers
that have Excel 2010 installed.
6. Click
Save 
button. A copy of this file is now saved in your My Documents folder.
7. The name you’ve given your file can now be seen at the very top of the screen.

How to save a file once it’s already been named
1. Click the 
File
tab in the top left corner of the screen.
2. Choose the 
Save 
option from the File menu.
How to exit Excel
Click the X button in the right corner of the screen (it should turn red when you
roll your mouse over it).
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How to open an existing Excel File
1. Once in Excel, click on the 
File
tab and then the 
Recent
option on the menu.
This will bring up a list of your recent documents. You can then click on one of
the files on the list to open it.
2. If you have not used the file you want to open recently, you will have to click on
the 
Open
option rather than the Recent option on the menu. The My Documents
menu will open and you can choose the file you want by doubleclicking on it.

How to change the size of a column
Manually:
1. Click on the right side of the column at the top of the sheet (where the column is
specified by letter) that you want to change the size of.
2. Drag mouse across to make the column wider or thinner.
Using the Format option:
1. Highlight the column(s) that you want to change the width of.
2. Click on the 
Format
button in the Cells toolbar of the Home tab (it’s to the
topright hand of the screen).
3. Click on 
Column Width 
and a popup box will appear.
4. Delete the current width with the 
Backspace
key and pick a number of your
choice, whether bigger or smaller.
5. If you click on 
AutoFit Column Width
in the Format button, Excel will
automatically change the width of the column(s) to the size of the widest data.

How to change the size of a row
Manually:
1. Click on the bottom of the row at the left side of the sheet (where the column is
specified by number) that you want to change the size of.
2. Drag mouse across to make the column taller or shorter.
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Using the Format option:
6. Highlight the row(s) that you want to change the height of.
7. Click on the 
Format
button in the Cells toolbar of the Home tab (it’s to the
topright hand of the screen).
8. Click on 
Row Height 
and a popup box will appear.
9. Delete the current height with the 
Backspace
key and pick a number of your
choice, whether bigger or smaller.
10. If you click on 
AutoFit Row Height
in the Format button, Excel will automatically
change the height of the row(s) to the size of the tallest data.

TIP Changing the size of a column or row also also counts as an edit that needs to be
saved if you want the spreadsheet to be formatted the same way the next time you
open the file.

Practice 5 Changing column and row size
1. Make Column E wider manually.
2. Make Column A wider using Autofit.
3. Change the height of Row 2 to 28.

The Undo arrow can undo a mistake.
If you click the wrong button or make a typing error, click the Undo icon,
which is found in the top left corner of the screen and is in the shape of a
small, blue arrow pointing left. It will go back and undo the last thing you
did (or more than that if you press it more than once) if you haven’t saved
the file. If you decide that you would rather not have pressed the Undo icon, the Redo
icon, a small blue arrow pointing right, will appear. Clicking the Redo button will undo
what you undid.

Using AutoSum for addition

9

AutoSum is a built in Excel formula for addition. AutoSum adds rows or columns of
numbers together to calculate the total sum.
1. Highlight the cells you want to add together plus an
extra blank cell the program can place the answer
in.
2. Click on the 
Formulas 
tab at the top of the screen.
3. Click 
AutoSum
button.
4. The sum will appear in the last cell you
highlighted.
5. Clicking on the cell with the sum in it will allow you
to see the formula for the sum in the Formula Bar.

How to do math calculations in Excel
1. Use builtin math formulas like SUM
Click on
the small arrow to the right or below the

AutoSum button to open math formulas menu. 
Average
calculates the average value of the numbers in the rows
or columns you highlighted. 
Max 
notes the largest
number you typed and 
Min 
notes the smallest numbers
you typed in the highlighted cells.

2. Write your own math formulas
Every formula in Excel must start with = (the equal sign). Use cell names and symbols
in writing a formula. For example, if you wanted to add together your food expenses for
July, August, and September, type the formula 
=B3+C3+D3
in Cell E3. will give you the
sum of the B3, C3, and D3 cells. As you type, a different colored box appears around
each Cell and the Cell Name itself will change to its corresponding color in the formula.
This allows you to check whether all the Cell Names you type into the formula are
correct. The formula is shown in both Cell E3 and in the Function bar above the
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spreadsheet.

Click the 
Enter
key on your keyboard. Look at where you typed the formula in Cell E3;
the sum will be there. However, if you look at the Function bar at the top of the
spreadsheet, it will still contain the formula you typed in.

How to write basic formulas
Addition: =B3+C3
Subtraction: =E8E3
Multiplication: =E8*4 NOTE Some formulas can include a number as a value, instead
of a Cell Name.
Division: =E6/E8

Copy formulas with Autofill
Excel will fill cells automatically to copy a formula and fill in numbers. The
FILL HANDLE is a small black square in the lower right corner of the highlight
area. Point at the fill handle with the mouse to turn the cursor into
Click the

.

and drag your mouse to fill the formula into empty cells.

Practice 6 Writing math formulas
Use Excel spreadsheet from Practice 3 to answer the questions below. Use AutoSum,
write a formula and/or use Autofill to answer.
1. Total Q3 expenses for Food, Clothes, Medicine, Phone, and Entertainment
2. Total expenses for July, August, and September
3. Total Q3 expenses (HINT: Sum should be in Cell E8)
4. Total Q3 expenses minus Medicine expenses
5. Total September expenses minus Food expenses
6. Q3 Food expenses are what percentage of total expenses? (Hint: Write as a
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division formula.)

Answers to Practice 6

You can even use a multiplication formula to calculate your annual budget: 
=E8*4
Error messages in Excel
Excel marks a formula with a math error or a cell with a
formula that differs from formulas in the cells around it
with a GREEN TRIANGLE in the top left corner of the cell. Click on the cell
with the green triangle and an exclamation point appears. Excel may show
you how to fix the formula. If not, you can go the Function bar and edit the formula
yourself. If you’re certain that the formula is correct, ignore the green triangle. It will not
show when you print.

Formatting in Excel
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In Excel, you can change the font size, typeset, and color of your data. You can bold,
italicize, and underline your data. You can align data to the left, right, or center.
How to add $ (dollar sign) to data
1. Highlight all the cells you wish
to format.
2. In the 
Numbers
menu, click on
the small downwards arrow to
the right of the button in the
shape of a dollar sign 
($)
. This is the
Accounting Number Format 
button.
3. You will be given the options of using
the currency symbols of American
dollars, British pounds, the Euro, or
more. All the cells you have
highlighted will now be shown as
currency.

How to convert data into percentages:
4. Highlight all the cells you wish to format.
5. In the 
Numbers 
menu, click on the button in the shape of the percentage symbol
(%)
. This will change the data in the cells you have highlighted into percentages.
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For example, 1 will become 100%, 10 will become 1000%, and .1 will become
10%.
6. If you want to change how many decimal places the percentage will go up to,
click on the small arrow in the lower right corner of the Numbers menu. This will
open up the 
Format Cells
dialog box. In the 
Numbers
menu, click on
Percentage
in the list of options. The right side of the dialog box will now have a
menu where you can increase or decrease the number of decimal places your
percentages will go up to.

Practice 7 Formatting activities
1. Add dollar signs ($) to all expense numbers.
2. Bold all of the data in Row 2.
3. Center all of the data in Row 2.
4. In Cell F3, enter the formula 
=E3/E8
. The answer will be a decimal. Change the
format of Cell F3 to a percentage with zero decimal places.

How to insert and delete rows and columns

Insert a column
1. Highlight the column to the right of where you
want the new inserted column to appear.
2. In the 
Cells
menu at the top of the screen, click
the small arrow underneath the 
Insert
button.
3. Click on 
Insert Sheet Column
.
4. A blank column will appear to the left of the
column you had highlighted.

Insert a row
1. Highlight the row below where you want the new inserted row to appear.
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2. In the 
Cells
menu at the top of the screen, click the small arrow underneath the
Insert
button.
3. Click on 
Insert Sheet Row
.
4. A blank row will appear above the row you had highlighted.
TIP: To insert a few columns or rows, highlight as many columns and rows as you want
to insert. For example, if you want to insert 3 columns, highlight 3 columns before doing
Step 2 above. If you want to insert 3 rows, highlight 3 rows instead.

Delete a column or row
1. Highlight column(s) or row(s) you wish to delete.
2. In the 
Cells 
menu, click the 
Delete
button.
TIP: Excel formulas and formatting are still okay after inserting and deleting columns or
rows.

Practice 8 Inserting and deleting
1. Insert 1 column between Column A and Column B. Label it June.
2. Insert 2 columns between Column D and Column E.
3. Delete one of the columns added in Step 2.
4. Insert 1 row above the row containing the word Entertainment. Label it School.
5. Use the Undo button to delete the row added
in Step 4.

How to print
1. Remember to save your work before printing.
2. Click 
File 
button in upper left corner of
screen.
3. Select 
Print
from menu.
4. Make sure your margins, orientation, and
number of copies is to your liking. Also, check
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the right side of the print preview to see how your printed
pages will look.
5. Click
Print 
button at the top center of the print preview.
Remember: In order to print, you must have a printer attached to
your computer as well as printer software installed on the computer.

For more help and practice
In Excel, click on the blue 
?
help button at the top right of the screen.
http://www.gcflearnfree.org/excel2010Videos plus slides

http://www.excelcentral.com/Sound and video plus slides

